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Getting started

What you will learn

This tutorial will guide you through the very first steps of getting to know VGSTUDIO MAX. You 
will see how to open a CT data set, familiarize yourself with the workspace, and learn how you 
can visualize the volume object in the 3D window and the 2D windows.

Tools you will need

Before you get started, you’ll want to make sure you have the following items:

Feature Description

Product name VGSTUDIO MAX

Release 2026.2

Example data ExampleData_vgstudiomax_GeneralTopics.zip, which is located on 

your download accounta. Unzip the content of the .zip file to a path 
of your choice. In this tutorial, we will use the following files:

– GolfBall.vgl

a https://download.volumegraphics.com/website/login.html

Document ID Tutorial-1061-v027-001-en
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Opening a .vgl project

There are various ways to load different types of data into VGSTUDIO MAX. A common use case 
is opening an existing .vgl project that contains one ore more volume objects. In this example, 
the volume object is a scanned golf ball.

1. Start VGSTUDIO MAX 2026.2 by using the new entry created by the installer in the 
Windows Start menu.

2. Select File >  Open and open the GolfBall.vgl example data set.

Alternatively, you can simply drag and drop the GolfBall.vgl example data set from your file 
browser into VGSTUDIO MAX.
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Exploring the workspace

Once the volume object has been loaded in the scene (i.e., the virtual space in which the object 
is located), it will be shown in the various windows of the workspace. The following figure shows 
a typical workspace layout of VGSTUDIO MAX:

Figure 3-1: Typical workspace

In the default layout of VGSTUDIO MAX you see

– the 2D windows (1);

– the 3D window (2);

– the Scene Tree tool (3);

– other tools, e.g., the Rendering tool (4).

In case the listed elements are not visible, toggle the visibility of the tools by activating them in 

the  Tools drop-down list on the Window tab. You can also realign the windows by selecting 

Window >  Quad.

Scene Tree

In the Scene Tree, the currently loaded objects and their associated analyses, geometry 
elements, GD&T features, and regions of interest (ROIs) are listed in hierarchical order. Each 
entry in the Scene Tree has a checkbox, which allows you to toggle its visibility in the 3D and 2D 
windows.
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Figure 3-2: Scene Tree with Volume 1

1. By default, the checkbox in front of Volume 1 is checked:

 The 3D window will show a 3D image of Volume 1.

 The 2D windows will show slices of Volume 1 from the right, front, and top view.

2. Uncheck the checkbox in front of Volume 1.

 Volume 1 will no longer be visible in the 2D windows and the 3D window.

3. Check the checkbox in front of Volume 1 to make it visible again.

Tool dock

The tool dock provides access to various tools in VGSTUDIO MAX. You can open and close a 

tool by activating and deactivating its entry in the  Tools drop-down list.

1. Go to the Window tab and in the  Tools drop-down list, deactivate, for example, the 
Rendering tool.
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Figure 3-3: Tools drop-down list

 The Rendering tool will disappear from the tool dock.

2. In the  Tools drop-down list, activate the Rendering tool.

 The Rendering tool will reappear in the tool dock.

3. In order to move the Rendering tool to another position on the screen, click and drag the 
title bar to a position outside the tool dock.

4. In order to enlarge the tool, click and drag any of the borders.

Figure 3-4: Enlarged Rendering tool

5. Drag the Rendering tool to reposition it back in the tool dock.
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3D window

The 3D window shows the rendered 3D image of the object currently selected in the Scene Tree. 

There are two basic transformation modes for the 3D window:  Rotate and  Move mode.

Figure 3-5: 3D window, Rotate and Move icons

1. To rotate the object, click the  Rotate icon and click and drag the object in the 3D window.

2. To move the object along the vertical and the horizontal axis, click the  Move icon and 
click and drag the object in the 3D window.

3. To move the object along the third axis (orthogonal to the screen, in your viewing direction), 
click the  Move icon and use the middle mouse button to click and drag the object.

You can also access the  Move and  Rotate functions via the Edit tab.

2D windows

By default, the 2D windows show slice views of the currently visible objects as seen from the top 
(along the z-axis), right (along the x-axis), and front (along the y-axis) of the current coordinate 
system.

1. Click the Top 1 window (the xy-plane) and use the mouse wheel to scroll through the object 
in the z-direction.

 A blue navigation plane that indicates the current slice position will appear in the 
other 2D windows and in the 3D window. The navigation plane will disappear after a 
few seconds of inactivity and reappear each time you change the slice position.
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 The slice position spin box at the bottom left of the Top 1 window will indicate the 
current slice.

You can also use the double-headed arrow  at the bottom left of the 2D window or click and drag 
a navigation plane to scroll faster through the slices.

2. Now do the same for the Right 1 window (the yz-plane) and for the Front 1 window (the 
xz-plane).

 The navigation plane for the yz-plane will be shown in red, and the navigation plane 
for the xz-plane will be shown in green.

Figure 3-6: 2D window with navigation planes

3. To display the navigation planes permanently, click the Navigation plane icon ( , , or 
) at the bottom in any of the 2D windows.

 The navigation planes will be permanently displayed in all three 2D windows and in 
the 3D window.

4. Click the Navigation plane icon ( , , or ) again to permanently switch the navigation 
planes off ; click it a third time to resume the temporary display ( , , or ).

Zooming in/out

1. In order to zoom the object in or out in a 2D window, hover the mouse pointer over a 2D 
window, hold down the Ctrl key, and scroll the mouse wheel. The zooming will use the 
mouse pointer as the center, so you will want to place your mouse pointer on an area of 
interest.

2. To reset the zoom and center the slice view of the object in the 2D window, click the 
 Focus selected object icon.
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Double-clicking the  Focus selected object icon will reset the zoom, center the slice view, and 
take you to the slice in the middle of the data set.

3. In order to zoom the object in or out in the 3D window, hover the mouse pointer over the 3D 
window and scroll the mouse wheel. Like in the 2D windows, the zooming will use the 
mouse pointer as the center, so you will want to place your mouse pointer on an area of 
interest.

4. To reset the zoom and center the object in the 3D window, click the  Center and focus 
camera icon.
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Hiding and revealing material in 2D

In the 2D windows, you can see that the golf ball consists of two different materials: a uniform 
outer shell and a speckled inner core. In order to hide or reveal one material, you can adjust the 
opacity curve in the Rendering tool. The opacity curve represents the linear mapping of gray 
values to opacities and is shown as a diagonal blue line in the histogram. The lower the line, the 
more transparent the corresponding gray value is rendered.

1. Make sure Volume 1 is selected in the Scene Tree.

2. In the Rendering tool, go to the Voxel tab.

 The Voxel tab shows a histogram of the gray values of the selected volume object.

 The opacity curve is shown as blue line that extends from the lower left to the upper 
right corner.

Figure 4-1: Rendering tool with opacity curve

3. In order to hide the outer shell and focus on the inner structures of the golf ball, click the 
second handle from the right and drag it to a position in the middle of the first material peak 
at the bottom of the histogram area, as shown in the image below.



Hiding and revealing material in 2D

VGSTUDIO MAX 2026.2 10
Tutorial: First steps 

4 

Figure 4-2: Rendering tool with adjusted opacity curve

 The color of the line segment changes from blue (unselected) to red (selected).

 The 2D windows show only the core of the golf ball.
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Figure 4-3: 2D view of the inner core of the golf ball

4. In order to restore the original opacity curve, right-click anywhere in the histogram area and 
select Reset opacity curve > Default from the context menu.
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Visualizing the surface in 3D

The Voxel tab of the Rendering tool shows a gray value histogram with an air peak on the left 
and—in the case of the golf ball—two material peaks on the right. To visualize the different 
materials of the volume in the 3D window, you can shift the red isosurface line in the histogram to 
a valley between the peaks. This line defines the gray value of the surface. All materials with 
gray values to the right of the line (i.e., higher gray values) will be displayed in 3D. 

Once a surface determination has been performed, this surface will by default be rendered, and 
the isosurface line will be fixed. To be able to move it, you will have to disable the rendering of the 
determined surface. Note that this will not remove the surface determination.

1. Make sure Volume 1 is selected in the Scene Tree.

2. Check whether Volume 1 has a surface determination: The icon in front of the volume 
object indicates whether the surface has been determined ( / ) or not ( ).

3. If the surface has been determined, go to the Voxel tab of the Rendering tool and click 
 Disable surface determination render settings.

Figure 5-1: Disabling the surface determination render settings

 The isosurface line becomes enabled and you can use it to override the rendering of 
the surface determination.

4. Click and slowly drag the isosurface line to the valley between the two material peaks.

 In the 3D window, the surface of the inner material of the golf ball will become visible.
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Figure 5-2: 3D view of the inner core of the golf ball
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Coloring different materials

In chapter 5 Visualizing the surface in 3D, you visualized the surface of the inner core of the golf 
ball by eliminating the material of the outer shell. In the following chapter, we will assign colors to 
specific gray value ranges to visually distinguish between the inner and outer materials of the 
golf ball.

1. In the Rendering tool, go to the Voxel tab.

2. Right-click the color area at the top of the Voxel tab and select Add color handle from the 
context menu or click the  Add color handle icon at the bottom of the histogram.

 A color handle will appear in the color area.

3. Repeat this procedure several times as shown in the image below:

Figure 6-1: Histogram with color handles

4. In the color area, double-click a color segment (i.e., the space between two color handles).

 The Select Color dialog will open.



Coloring different materials

VGSTUDIO MAX 2026.2 15
Tutorial: First steps 

6 

Figure 6-2: Select Color dialog

5. Choose a color and click OK to apply it to the gray value range defined by the first color 
segment.

6. Repeat step 4 and step 5 to apply a color to each color segment.

 Depending on the colors you picked, the histogram will show a color gradient similar 
to the image below:
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Figure 6-3: Histogram with colored gray value ranges

 In the 2D windows, the inner and outer materials of the golf ball are shown in the 
colors of the corresponding gray value range.
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Figure 6-4: Colored gray value ranges in the 2D window

7. If you are not satisfied with the results, you can modify the coloring by clicking a color 
handle and dragging it to a new position.

You can also use intervals to define gray value ranges. These options are available in the context 
menu of the histogram area. For more detailed information, see the Reference Manual.

8. In order to toggle between showing the slice images in their original brightness, contrast, 
and color and showing them in the settings specified in the Rendering tool, click the 

 Original display mode icon at the bottom of the 2D window.

Coloring different materials using color handles is a quick way to visualize the materials, but it has 
its limitations. VGSTUDIO MAX offers other possibilities to separate different materials more 
accurately, such as segmentation, by creating regions of interest or performing a porosity/inclu-
sion analysis. For more detailed information on these methods, see the tutorials available under 

Help >  Show tutorials or refer to the Reference Manual under Help >  Show manual.
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You’ve mastered this tutorial... now 
what?

Congratulations! You have successfully mastered your first steps in VGSTUDIO MAX.

We hope you enjoyed this tutorial. Ready to learn more? Swing by our documentation landing 

page (Help >  Show tutorials) for a complete list of topics to choose from.

For more detailed information, please refer to our reference manual (Help >  Show manual) 
or contact VG Support and we’ll be happy to help.

Ready to graduate from tutorial to in-depth training? Contact VG Academy for training and 
workshop options that will provide you even deeper insight into the complete functionality of our 
software products.
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